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پیشگفتار مولف

نرم افزار تکلا استراکچرز  از سال 2016 تاکنون سه نسخه جدید را روانه بازار کرده که با نسخه های قدیمی متفاوت بوده و 
تغییرات مثبتی در آنها ایجاد شده است اما تاکنون هیچ کتاب و مرجع فارسی برای آن نگارش نشده است. لیکن ما بر آن شدیم 
که با کمک انتشارات علم عمران کتابی جامع و کامل منطبق با آخرین نسخه نرم افزار یعنی نسخه 2018 تهیه کنیم. در کتاب 
پیش رو به کلیه تغییرات و ابزارهای اضافه شده در نسخه جدید اشاره شده است همچنین روند تالیف کتاب کاملا بر مبنای 
سیلابس های آموزشی این نرم افزار است بنابراین کاربر می تواند کتاب را فصل به فصل مطالعه نموده و در انتها پروژه سازه 

فولادی فصل آخر را برای تثبیت مطالب انجام دهد. 
خوانندگان گرامی می توانند در فرآیند مطالعه کتاب در صورت مواجه با هر گونه مشکل و ایرادی موارد را در انجمنی که 
بدین منظور در سـایت تخصصی تکلا به آدرس www.teklastructures.ir ایجاد شـده اسـت مطرح نموده و مشکلات خود 
را رفع نمایند همچنین ایرادهای نگارشی کتاب را که سعی بر آن شده که به حداقل ممکن برسد را نیز مطرح نموده تا برای 

چاپ های بعدی مورد اصلاح قرار بگیرد.  
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فصل اول
مبانی مقدماتی و نحوۀ شروع کار با نرم‌افزار

1-1- مقدمه
نرم‌افزار Tekla Structures محصول شرکت تکلا می‌باشد که در سال 1966 میلادی در کشور فنلاند پا به عرص ۀوجود نهاد. 
این نرم‌افزار پس از طی مراحل تکمیلی خود، با نام تجاری Xsteel فعالیت گسترده‌ای را آغاز نمود و به موازات افزایش قابلیتها 

و بخش‌های جانبی به آن، درسال2004 میلادی به Tekla Structures تغییر نام داد. 
در حال حاضر Tekla یکی از زیر مجموعه‌های کمپانی Trimble بوده که علاوه بر شاخه Structures که در این کتاب به 

بررسی آن پرداخته می‌شود، دارای زیر شاخه‌های زیر نیز می‌باشد:
Tekla Structural Designer: نرم‌افزاری سـت که به طور اختصاصی برای تحلیل و طراحی سـازه‌های سـاختمانی به کار 

برده می‌شود.

Tekla Structural Designer شکل 1-1- نمایی از محیط



 Tekla Structures 2018 10 / آموزش کاربردی نرم افزار

Tekla Tedds: نرم‌افزاری ست که قادر به تهیه دفترچه محاسبات خودکار بر اساس قالب‌های آماده و از قبل طراحی شده است.

Tekla Tedds شکل 1-2- نمایی از محیط

Tekla BIMSight: نرم‌افزاری ست برای مشاهده و بررسی ارتباط بین تمامی اجزای سازه. در این مدل سه بعدی می‌توان 

تمامی تداخل‌ها را بررسی کرده و در صورت نیاز برای درج اطلاعات بر روی اجزای مدل از کامنت‌های مختلف استفاده کرد. 

Tekla BIMSight شکل 1-3- نمایی از محیط

Tekla Field 3D: نرم‌افزاری ست برای مشاهده مدل‌های BIM در گوشی‌های تلفن همراه و تبلت‌های هوشمند.

Tekla Field 3D شکل 1-4- نمایی از محیط
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Tekla Civil: نرم‌افزاری ست از نوع BIM که از حیث جامعیت شامل تمامی زمینه‌های مهندسی عمران است.

Tekla Civil شکل 1-5- نمایی از محیط

در ادام ۀنگارش این کتاب به نرم‌افزار Tekla Structures به اختصار "نرم‌افزار تکلا" و یا "نرم‌افزار" گفته می‌شود. 
نسخه‌هایی از نرم‌افزار تکلا که توسط مهندسین مورد استفاده قرار می‌گیرند اغلب شامل نسخه‌های 19، 20 و 21 می‌باشند 
که عملًا تفاوت چندانی با یکدیگر ندارند اما از سال 2016 سیستم معرفی نسخه‌های تکلا تغییر پیدا کرد بطوریکه سه نسخه 
آخر تکلا نسـخه 2016، 2017 و 2018 نام گرفته‌اند. سـاختار این کتاب که بر اسـاس نسـخ ۀ2018 تکلا نوشـته شده است 

می‌تواند مرجع قابل اطمینانی برای سایر نسخه‌های دیگر نرم‌افزار نیز باشد. 

1-2- هدف از یادگیری نرم‌افزار تکلا
هر نرم‌افزاری که به بازار عرضه می‌گردد بسته به قابلیت‌ها و توانایی‌های خود به منظور گره گشایی بخش خاصی از صنعت 
بکار برده می‌شـود. نرم‌افزار تکلا امروزه در صنعت سـاخت بیش از 80 کشـور دنیا وارد شـده اسـت و از این حیث در زمر ۀ
نرم‌افزارهای مهندسی معتبر و پرفروش قرار می‌گیرد. متأسفانه بدلیل قفل شکسته بودن اکثر نسخه‌های این نرم‌افزار در ایران، 
انجـام عملیـات تحلیـل و طراحی در آن امکان پذیر نیسـت لیکن به منظور اهداف پرکاربرد دیگری از این نرم‌افزار اسـتفاده 

می‌گردد که بخشی از آنها عبارتند از: 
yy مدل‌سازی انواع سازه‌های فولادی، بتنی و همچنین سازه‌های ترکیبی و پیچید ۀصنعتی
yyمدل‌سازی جزئیات و اتصالات سازه‌ای بصورت خودکار و یا دستی
yy به منظور تسریع در عملیات )Team Work( امکان فعالیت همزمان چندین کاربر برروی یک پروژه برمبنای کار تیمی

)Multi-User مدل‌سازی )در حالت
yy ،تولید انواع نقشه‌های کارگاهی از جمله نقشه‌های قطعه زنی )درج جزئیات برشکاری و سوراخکاری(، نقشه‌های ساخت

مونتاژ و نقشه‌های نصب سازه که به طور چشمگیری باعث کاهش خطاهای انسانی در حین تولید نقشه‌ها به روش 
سنتی و با نرم‌افزارهایی نظیر Autocad خواهند شد

yy گزارش خروجی دقیقی از مصالح، احجام و المانهای استفاده شده در پروژه که کمک شایانی به تهی ۀلیستوفر بدون خطا
خواهد نمود و می‌توان بر اساس آن برآورد اولی ۀصحیحی از لیست خریدهای پروژه داشت
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yy Autocad امکان تبادل اطلاعات با سایر نرم‌افزارها از جمله دریافت و صدور اطلاعات به نرم‌افزار
yyبررسی وضعیت پروژه از نظر پیشرفت کار در زمانهای مختلف و ارائه یک برنام ۀزمانبندی مناسب
yy امکان ارائه توالی نصب بخش‌های مختلف سازه و بکارگیری تکنیک‌های مدیریت پروژه در حین عملیات ساخت

1-3- نحوۀ نصب نرم‌افزار
مراحل نصب نرم‌افزار تکلا بسته به شرکتی که آن را تهیه نموده اید ممکن است که متفاوت باشد. با توجه به اینکه معمولاً 
نرم‌افزارهای موجود در بازار قفل شکسته می‌باشند فلذا هر یک از آنها دارای عملیات نصب و Crack متفاوتی می‌باشند اما به 
طور کلی پس از نصب نرم‌افزار، نصب محیط )Environment(، فایل موجود در پوشه Crack را کپی کرده و در مسیر نصب 

نرم‌افزار Paste می‌کنیم. این مسیر عبارتست از:
C:\Program Files\Tekla Structures\2018\nt\bin

نسخ ۀ2018 نرم‌افزار تکلا با سیستم عاملهای Window 10 و Window 7، Window 8.1 از نوع 64 بیتی سازگاری کامل 
دارد و برای نصب این نسخه نیاز به  Microsoft.Net Framework 4.5.1یا بالاتر است. 

1-4- چگونگی شروع کار با نرم‌افزار
پس از نصب هر نسخه‌ای از نرم‌افزار Tekla Structures برروی دکم ۀStart درمحیط ویندوز کلیک کنید و مسیر زیر را برای 

اجرای برنامه طی نمایید: 
All Programs > Tekla Structures 2018 > Tekla Structures 2018

با طی مسیر فوق و یا کلیک بر روی آیکون نرم‌افزار، ابتدا پنجر ۀمحاوره‌ای Tekla Structures – Choose Setup به کاربر 
نمایش داده می‌شود که در آن محیط برنامه، ساختار نوار ابزاری و کارکرد‌های متفاوت آن قابل انتخاب می‌باشد. 

Tekla Structures – Choose Setup شکل 1-6- پنجرۀ محاوره‌ای

این پنجر ۀمحاوره‌ای متشکل از 3 بخش تنظیمی بوده که توضیح هر کدام از آنها در زیر آمده است:  
Environment: به هنگام نصب نرم‌افزار تکلا، ضرورت دارد که به همراه آن حداقل یک محیط کاری )Environment( نیز 

نصب گردد. هر یک از محیط‌های کاری دربردارند ۀمشـخصات مصالح، گزارش ها، جداول، اتصالات، مقادیر پیش فرض 
تنظیمات و پروفیل‌های معینی با استاندارهای خاص یک کشور و یا یک منطقه می‌باشند. به طور کلی 33 محیط برای تکلا 
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قابلیت انتخاب و نصب دارد که در جدول 1-1 به برخی از آنها اشاره شده است. 

جدول 1-1- معرفی تعدادی از محیط‌های قابل نصب برروی نرم‌افزار تکلا

PolandAustralasia

RussiaChina

SouthAfricaDefault 
UKGermany

US (imperial)India

US (metric)Italy

اگر در ابتدا محیطی نصب نشـده باشـد می‌توان از گزینه blank project اسـتفاده نمود که چارچوبی خام و اولیه همراه با 
تنظیمات عمومی دارد. از آنجایی که پروفیل‌های موجود در محیط Default شباهت زیادی با پروفیل‌هایی که در ایران استفاده 
می‌شوند دارند لذا بهتر است که همواره از این محیط استفاده کنیم و سایرمحیط‌ها را صرفاً به هنگام نیازکاری نصب نماییم.

Role: هنگامی که محیط مشخصی در بخشEnvironment انتخاب شد، متناسب با آن محیط، تکلا فازهای کاری متنوعی 

را به کاربر پیشنهاد می‌دهد. با انتخاب هر یک از این فازها، رابط کاربری برنامه اعم از دستورها، نوارابزارها و... مطابق با آن فاز 
کاری هماهنگ خواهد شد. انتخاب هر کدام از این فازها بستگی به هدف شما دارد ولی در حالت کلی بهتر است که همواره 
از فاز کاریAll  استفاده کنیم که مشتمل بر تمامی فازهای موجود می‌باشد. در جدول 1-2 به طور نمونه به فازهای کاری قابل 

استفاده در محیط  Default اشاره شده است. 

Default جدول 1-2- فازهای کاری قابل استفاده در محیط

Type of Roles in Default Environment

Concrete Contractor All 
Precast Concrete DetailerGeneral Contractor

 Steel DetailerRebar Detailer

 Engineer

License: در این بخش می‌توانیم ساختار پروژ ۀخود را به نرم‌افزار معرفی کنیم. با انتخاب هر ساختاری به غیر از ساختار

Full ، برخی از دستورها و ابزارها قابل استفاده و رویت نخواهند بود و بالطبع حجم کمتری از نرم‌افزار را اشغال خواهند نمود. 

بدلیل اینکه در فرآیند مدل‌سازی اغلب به اکثر دستورها و تنظیمات نرم‌افزار احتیاج داریم لذا در این کتاب همواره از ساختار 
Full استفاده خواهیم نمود. انواع ساختارهایی که در تکلا قابل انتخاب می‌باشند در جدول 1-3 آورده شده‌اند. 

جدول 1-3- ساختارهای قابل استفاده در نرم‌افزار

Type Of Licenses

Precast Concrete DetailingProject Viewer

Steel DetailingDrafter

 Full Project Manager

PrimaryConstruction Modeling

EducationalEngineering

DeveloperRebar Detailing

Production Planner
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همان‌گونـه کـه پیـش تر نیز ذکر گردید، انتخاب هر یک از سـاختارها به غیر از سـاختار Full منجر به اعمال یکسـری از 
محدودیت‌ها در دسـتورها و ابزارهای نرم‌افزار خواهد شـد. در جدول 1-4 به پاره‌ای از این سـاختارها و محدودیتها اشـاره 
شده است که برای اطلاعات تکمیلی آورده شده و ضرورتی به مطالعه آن نیست. بطورمثال در ساختار Full تمامی ویژگی‌ها 
فعال و قابل استفاده است اما در ساختار Drafter غالباً از ویژگی Viewing می‌توان استفاده نمود بطوریکه در این ساختار اکثر 

دستورهای اصلی غیر فعال بوده و امکان تعریف یک مدل جدید در آن وجود نخواهد داشت.    

جدول 1-4- تعدادی از ساختارهای قابل انتخاب در تکلا و محدودیت‌های آنها 

DrafterPrimaryRebar Detailing Precast Concrete
DetailingSteel DetailingFull

                           ساختار
          ویژگی ها

Viewing


Grids, Construction Lines, Points

Building Elements

Assemblies

Precast Cast Unit

Pour Modeling

Numbering

Conceptual Components

Steel Components

Concrete Components

Lotting

Sequencer

User-defined attributes

Project status visualization

Multi-user

Locking

Clash Check manager

Task manager

Organizer

لازم به ذکر اسـت که پس از ایجاد یک مدل جدید نیز می‌توان تنظیمات اولیه تکلا را تغییر داد، بدین منظور کافیسـت از 
منوی File دستور Settings را اجرا کرده و در بخش License تنظیمات را تغییر داد.
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شکل 1-7- نحوه تغییر تنظیمات اولیه تکلا پس از گشودن یک مدل جدید

پس از انجام تنظیمات ذکر شده در پنجر ۀمحاوره‌ای Tekla Structures– Choose Setup برروی دکم ۀOK کلیک کرده تا 
وارد پنجره خوش آمد گویی نرم‌افزار شوید.

شکل 1-8- پنجرۀ محاوره‌ای خوش آمد گویی نرم‌افزار

در پنجره محاوره‌ای گشوده شده:
yy.می‌توان به مدل‌هایی که اخیرا استفاده شده است دسترسی داشت Recent در تب
yy.کلیه مدل‌های از قبل ذخیره شده نمایش داده خواهند شد All model در تب
yy  .قادر به ایجاد یک مدل جدید خواهیم بود New در تب

1-5- ایجاد یک مدل جدید
برای ایجاد یک مدل جدید، به تب New رفته و تنظیمات زیر را انجام می‌دهیم:

 Newدر این بخش نام دلخواهی را برای مدل مورد نظر انتخاب می‌کنیم )درصورت عدم تغییر نام مدل، تکلا از نام :Name

model استفاده می‌کند(. 

Place in: در این بخش محل ذخیر ۀپروژه )مدل( مشخص می‌گردد. )مسیر پیش فرض نرم‌افزار برای ذخیر ۀفایل مدل، 

همان درایوی ست که تکلا در آن نصب شده است(. به منظور مشخص نمودن سریعتر پوش ۀذخیر ۀفایل مدل، می‌توان از 
دکم ۀBrowse نیز استفاده نمود. 
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 New شکل 1-9- تنظیمات تب

Template: در نرم‌افـزار تـکلا ایـن قابلیت وجـود دارد که بتوان مدلهای دلخواهی را به عنوان مدل الگو معرفی کرده و در 

صورت نیاز بصورت سریعتری از آنها استفاده نمود. دربخش Template به طور پیش فرض چندین مدل الگو وجود دارد که 
هیچ یک کاربرد چندانی ندارند و ما همواره از گزین ۀ)Blank( استفاده می‌کنیم. 

مدل‌های الگو در مسیر زیر واقع شده‌اند:
C:\ProgramData\TeklaStructures\2018\Environments\default\model_templates 

 )XML با فرمت( TeklaStructuresModel درصورت تمایل می‌توانید مدل موردنظر خود را در مسیر فوق کپی کرده و فایل
را که در پوش ۀاین مدل الگو وجود دارد با یک برنام ۀویرایشگر متنی )به طورمثال Notepad( همانند شکل زیر اصلاح و ذخیره 

کنید. اکنون نام مدل کپی شده نیز در لیست نام مدل‌های الگو درج خواهد شد. 

  TeklaStructuresModel.XML ب( فایل                   True به False 1 ازstTemplate الف( اصلاح تنظیم
شکل 1-10- نحوۀ ایجاد مدل‌های الگو  

Type: در این بخش مشخص می‌گردد که عملیات مدل سازی از نوع تک کاربره )Single-user model( و یا چندکاربره 
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)Multi-user model( خواهد بود. اگر پروژه به صورت انفرادی انجام می‌شـود، گزینه Single-user model و اگر پروژه به 
صـورت گروهـی انجام می‌پذیرد گزینـه Multi-user model را انتخاب کنیـد. در پروژه‌های بزرگ که از حالت چند کاربره 
استفاده می‌شود، سیستمهای مختلف تشکیل یک شبکه را می‌دهند و همزمان افراد گوناگونی در فازهای مشخصی بر روی مدل 
کار می‌کنند که در صورت استفاده از این حالت، نام شبک ۀمورد استفاده در فیلد Server )پس از انتخاب گزینه چند کاربره( 
درج می‌گردد. همچنین برای کار کردن با حالت چند کاربره، باید نرم‌افزار جانبی MultiuserServer نیز نصب گردد. در تمامی 

بخش‌های این کتاب از حالت )Single-user model( استفاده خواهیم نمود. 
پس از انجام تنظیمات ذکر شده، بر روی دکم ۀCreate کلیک کنید تا یک مدل جدید ایجاد گردد.

1-6- آشنایی کلی با محیط نرم‌افزار
محیط کاربری نرم‌افزار تکلا در سه نسخه اخیر با نسخه‌های قدیمی تر تفاوت زیادی داشته و نوارمنوها به ‌Ribbonها تبدیل 
شده‌اند که بر اساس نیاز کاربر می‌توانند بصورت سفارشی تنظیم گردند. بخش‌های مختلف پنجر ۀاصلی نرم‌افزار در شکل 

1-11 نشان داده شده است که در ادامه به ترتیب شماره‌ها به شرح هر یک از آنها خواهیم پرداخت. 

7

5

2

1
3

9

4

8
6

10 12 11

شکل 1-11- بخش‌های مختلف پنجرۀ اصلی نرم‌افزار

1-6-1- پنجره نمای جاری
مدل تکلا داخل این نما قرار دارد، در ابتدا این نما شامل ناحیه کاری و خطوط شبکه پیش فرض است.

1-6-2- سیستم مختصات جهانی 
مکعب سبز رنگی که در مبدأ 0,0,0 قرار گرفته است نشان دهنده سیستم مختصات جهانی می‌باشد.

1-6-3- ناحیه کاری
مکعب مستطیلی که محیط بر خطوط شبکه است و نشان دهنده ناحیه کاری می‌باشد، در نمای مدل صرفا اجزا و قطعاتی قابل 

مشاهده خواهند بود که در ناحیه کاری قرار داشته باشند. 

1-6-4- مختصات محلی
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این نماد مشخص کننده جهت‌های مثبت مختصات محلی است.

File 1-6-5- منوی
توسط این آیکون می‌توان به منوی فایل دسترسی داشته و عملیاتی نظیر ایجاد مدل، ذخیره مدل، فراخوانی، چاپ نقشه‌ها و... 

را انجام داد. 

Ribbon -6-6-1
‌Ribbonها دربردارنده کلیه دستورها و ابزارهای ترسیمی بوده و می‌توان آنها را بصورت سفارشی تنظیم نمود.

1-6-7- نوار عنوان
این نوار به طور پیش فرض شامل دستورهای Save، Undo،  Redoو Undo history است.

1-6-8- فیلد جستجو
اگر دستور و یا پنجره محاوره‌ای ابزاری را نتوانستیم به طور مستقیم پیدا و اجرا کنیم می‌توانیم از این فیلد جستجو که با نام 

Quick Launch شناخته می‌شود استفاده کنیم. 

1-6-9- نوار جانبی
توسط این نوار جانبی می‌توان به کامپوننت‌ها و مدلهای مرجع که از سایر نرم‌افزارها فراخوانی شده‌اند دسترسی داشت.

1-6-10- نوار ابزار انتخاب
اغلب اوقات در پروژه‌های کاری خود با مواردی مواجه می‌شویم که نیاز داریم موضوعات خاصی را در مدل  انتخاب کنیم، 
بهترین راهکار برای اینگونه موارد استفاده از ابزارهای انتخاب و عملیات فیلتر کردن اعضا می‌باشد. به عملکرد دکمه‌های این 
نوار ابزار در بخش 1-7-9 اشـاره شـده اسـت بطوریکه با مطالع ۀاین بخش و پیگیری کاربردهای آن در فصول آتی در این 

موضوع تبحر پیدا خواهید نمود. 

1-6-11- نوار ابزار ربایش
در موارد بیشماری که نیاز داریم برروی نقاط خاصی از یک قطعه و یا یک شی کلیک کنیم از دکمه‌های این نوار ابزار استفاده 
می‌کنیم. بطورمثال یک ستون فلزی صرفاً با معرفی یک نقطه ترسیم می‌گردد که برای معرفی آن می‌توان از دکم ۀربایش تقاطع 

خطوط شبکه استفاده نمود. به عملکرد دکمه‌های مختلف نوارابزار ربایش در بخش 1-7-10 اشاره شده است. 

1-6-12- نوار وضعیت
نوار وضعیت که تحتانی ترین نوار محیط کاربری اسـت متشـکل از چندین بخش بوده که اطلاعات بخصوصی را به کاربر 
نمایش می‌دهد. در سمت چپ این نوار، دستورالعمل استفاده از ابزارها و دستورهای اجرا شده و سایر اطلاعات و پیغام‌های 
نرم‌افزار نشان داده می‌شود، در قسمت میانی نوار وضعیت اطلاعات تنظیمی بخشOptions  نمایش داده می‌شود و در سمت 
راسـت نـوار وضعیـت اطلاعات مربوط به شـمار ۀفاز جاری مـدل و تعداد قطعات انتخابی درج می‌گردد. به منظور کسـب 

اطلاعات بیشتر در مورد نوار وضعیت به بخش 1-7-8 مراجعه کنید. 

1-7- یادگیری ابزارهای اولیه تکلا
قبل از اینکه کاربر قادر به توانایی کار کردن با نرم‌افزار تکلا باشد، بایستی از اصول اولیه و قواعد نرم‌افزار اطلاعات کافی داشته 
باشد، هر چند که اکثر این اصول و ابزارها در تمامی نرم‌افزارهای مهندسی مشابه یکدیگر بوده اما دانستن آنها لازمه کار کردن 

با نرم‌افزارهای اینچنینی است.
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1-7-1- ایجاد مدل جدید
برای ایجاد یک مدل جدید می‌توان از منوی File دستور New را اجرا کرد. تنظیمات ایجاد یک مدل جدید در بخش 5-1 

توضیح داده شده است.

1-7-2- بازکردن مدل
برای باز کردن یک مدل موجود می‌توان از منوی File دستور Open را اجرا کرد.

Open شکل 1-12- دستور

در این بخش:
Recent: برای باز کردن مدل‌هایی به کار می‌رود که اخیرا مورد استفاده قرار گرفته‌اند.

All models: برای باز کردن کلیه مدل‌های موجود به کار می‌رود.

Browse shared models: برای باز کردن مدل‌های به اشترا کگذاشته به کار می‌ورد.

در نرم‌افزار تکلا بصورت همزمان می‌توان صرفاً برروی یک مدل کار کرد. درصورت نیاز به گشـودن مدل جدید، تکلا 
پیغامی را مبنی بر ذخیر ۀمدل فعلی نمایش خواهد داد فلذا با بستن مدل فعلی، مدل جدید گشوده خواهد شد. 

1-7-3- ذخیره مدل
به منظور ذخیر ۀعملیات صورت گرفته در مدل از آیکون Save در نوار عنوان استفاده می‌شود. با توجه به این نکته که نرم‌افزار 
تکلا دارای خاصیت ذخیر ۀخودکار )Auto Save) می‌باشد ولی بهتر است که در هرمقطع از عملیات مدل‌سازی برروی آیکون 

دستور Save کلیک و یا از کلید میانبر Ctrl+S استفاده کنیم.

Save شکل 1-13- دستور

به منظور تنظیم بازه‌هایی که توسط آن نرم‌افزار به ذخیر ۀخودکار عملیات صورت گرفته برروی مدل می‌پردازد دستور واقع 
در مسیر زیر را دنبال کنید. 

File > Settings > Options > General - Autosave

Zoom 1-7-4- عملیات
از دسـتورهای Zoom که در تب View واقع شـده اسـت به منظور بزرگ نمایی و کوچک نمایی اسـتفاده می‌شـود. عملیات  
Zoomدر حالت معمولی ازطریق دکم ۀچرخشی وسط موس و همچنین ازطریق دکمه‌های Page Up  و Page Down صفحه 
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کلید نیز قابل اجرا می‌باشد. به عملکرد دستورهای مختلف این زیر منو در جدول 1-5 اشاره شده است. 

Zoom شکل 1-14- ابزارهای

Zoom جدول 1-5- شرح عملکرد دستورهای

دستورعملکرد
Drag بزرگ نمایی توسط کلیک کردن و یا معرفی ناحی ۀبزرگنمایی با عملZoom In

Drag کوچک نمایی توسط کلیک کردن و یا معرفی ناحی ۀکوچک نمایی با عملZoom Out

Zoom Originalبازگشت به حالت بزرگ نمایی استاندارد

Zoom Previousبازگشت به حالت بزرگ نمایی انجام گرفته در مرحل ۀقبل

Zoom Selectedبزرگنمایی برروی نمای جاری بطوریکه اشیای انتخاب شده در مدل در مرکز نما قرار بگیرند

 Move1-7-5- عملیات
از Move به منظور عملیات جابجایی برروی نما بکار می‌رود. دستورهای جابجایی در نما در جدول 1-6 بررسی شده‌اند. 

جدول 1-6- شرح عملکرد دستورهای جابجایی در نما

دستورعملکرد

 Pan جابجایی توسط دستورPan

Move Rightجابجایی به سمت راست نما )دکم ۀجهت نمای سمت راست صفحه کلید(

Move Leftجابجایی به سمت چپ نما )دکم ۀجهت نمای سمت چپ صفحه کلید(

Move Downجابجایی به سمت پایین نما )دکم ۀجهت نمای سمت پایین صفحه کلید(

Move Upجابجایی به سمت بالای نما )دکم ۀجهت نمای سمت بالای صفحه کلید(

)Insertجابجایی بر اساس موقعیت قرارگیری نشانگر موس )دکم ۀCenter by Cursor

جابجایی توسـط نشـانگر Pan از طریق فشـردن دکم ۀوسـط موس و حرکت آن، نیز امکان پذیر می‌باشـد که از این نوع 
 Middle Button جابجایی در نما استفاد ۀزیادی می‌شود. برای استفاده از این نوع جابجایی، نیاز است که تیک تنظیمی دستور



 / 21فصل اول: مبانی مقدماتی و نحوۀ شروع کار با نرم‌افزار

Pan را از مسیر File > Settings فعال کنید. 

 Rotate1-7-6- عملیات
از Rotate برای چرخش در نما استفاده می‌شود. از طریق عملیات چرخش در نما می‌توان اجزای مدل را از زوایای گوناگون 

بررسی کرد و نقایص احتمالی موجود را مرتفع نمود. به عملکرد Rotate در جدول 1-7 اشاره شده است.  

جدول 1-7- شرح عملکرد دستورهای چرخش

دستورعملکرد
پس از اجرای این دستور )کلید میانبر Ctrl+R( با معرفی یک نقط ۀدلخواه، مرکز دوران را 
مشخص کنید و سپس با پایین نگاه داشتن دکم ۀسمت چپ موس و جابجایی آن به عملیات 
چرخش در مدل بپردازید )برای پایان دادن به عملیات چرخش از دکم ۀEsc استفاده کنید(. 

Rotate With Mouse

پس از اجرای این دستور، می‌توان مرکز دوران را با معرفی یک نقط ۀجدید اصلاح نمود. 
Set View Point)کلید میانبر V(. علامت زیر در مدل نشان دهنده مرکز چرخش نما می‌باشد. 

یکی از روش‌های رایج برای عملیات چرخش در مدل این اسـت که بصورت همزمان کلید Ctrl و دکم ۀوسـط موس را 
پایین نگاه داشت و سپس به جابجایی نشانگر موس پرداخت.  

1-7-7- لغو دستورها 
برای لغو و یا پایان دادن به فعالیت یک دستور، از Interrupt استفاده می‌گردد. دستور Interrupt با فشردن دکم ۀEsc از صفحه 
کلید و یا کلیک راست نمودن و اجرای دستور Interrupt نیز قابل اجراست. همچنین می‌توان برای اجرای سریع این دستور 

از آیکون آن نیز استفاده کرد.

Interrupt شکل 1-15- آیکون دستور
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 )Status bar( 1-7-8- نوار وضعیت
پیغام‌ها و دستورالعمل‌های تکلا توسط نوار وضعیت به کاربر منتقل می‌شود. هنگامیکه با عملکرد یک دستور ترسیمی و نحو ۀ
معرفی نقاط و پارامترهای آن آشنایی کاملی ندارید می‌توانید از دستورالعمل‌های نوار وضعیت که در سمت چپ این نوار ابزار 

نمایش داده می‌شوند استفاده کنید. 
نوار وضعیت علاوه بر دسـتورالعمل‌های مربوط به عملکرد فرامین مختلف،پیام‌های خطا، اطلاعات زیر را نیز در اختیار 

کاربر قرار می‌دهد:
yy Ortho, SmartSelect ,Drag and drop وضعیت فعال یا غیر فعال بودن تنظیمات مربوط به

 O ,S ,D با علائم اختصاری     
yy Scroll ویا Pan نحو ۀعملکرد دکم ۀچرخشی وسط موس در حالت
yy)شمار ۀفازی که در حال کار کردن با آن هستید )فاز جاری
yy تعداد اشیا و گیره‌هایی که به حالت انتخاب درآمده‌اند

شکل 1-16- بخشی از اطلاعات نمایش داده شده در نوار وضعیت

 )Selecting Toolbar( 1-7-9- نوار ابزار انتخاب
از بخش‌های مختلف این نوارابزار برای انتخاب و یا عدم انتخاب اشیای خاص مدل استفاده می‌گردد. بکارگیری این نوارابزار 
زمانی مفید است که بخواهیم به سرعت و بدون خطا اشیای مورد نظر خود را در مدل انتخاب کنیم. به طور مثال اگر بخواهیم 

در مدل جاری صرفاً جوش‌ها به حالت انتخاب در بیایند از دکم ۀ استفاده می‌کنیم. 

شکل 1-17- نوار ابزار انتخاب

قبل از اینکه به نحوه انتخاب قطعات توسط نوار ابزار انتخاب اشاره شود، توجه شما را به ذکر چند نکته جلب می‌کنیم:
نکته 1: در نرم‌افزار تکلا برای اینکه یک شی یا قطعه انتخاب گردد کافیست بر روی آن کلیک کرده و اگر بخواهیم پنجره 

ویژگی‌های آن گشوده شود بر روی آن دابل کلیک می‌کنیم.
نکته 2: در نرم‌افزار تکلا به المانهایی که دارای وزن هستند )همانند تیر، ستون، ورق و...( واژه قطعه )Part( و به المان‌هایی 

که دارای وزن نیستند )همانند خطوط شبکه، نقاط، ابزارهای کمک ترسیمی و...( واژه شی )Object( اطلاق می‌شود.
نکته 3: برای انتخاب بیش از یک قطعه در نرم‌افزار تکلا، هم می‌توان از دکمه Ctrl و هم می‌توان از دکمه Shift استفاده کرد. 
 deselect این خاصیت Shift انتخاب شوند با کلیک مجدد از انتخاب خارج شده اما در Ctrl با این تفاوت که قطعاتی که با

برقرار نیست. 
نکته 4: برای انتخاب گروهی از قطعات می‌توان از مستطیل انتخاب در نما نیز استفاده کرد. بدین شکل که اگر این مستطیل 
از چپ به راست ترسیم شود باید کلیه اجزا داخل این مستطیل باشند اما اگر این مستطیل از راست به چپ ترسیم شود حتی 

اگر بخش کوچکی از یک شی داخل این مستطیل باشد به حالت انتخاب در می‌آید. 
نحو ۀعملکرد ابزارهای انتخاب بدین ترتیب اسـت که برای انتخاب اشـیای موردنظر، برروی دکم ۀمربوط به آن کلیک 

می‌شود تا رو به پایین فشرده شود. 
درصورت عدم برآورده شدن نیاز شما در انتخاب اشیا، از فیلترهای انتخاب از دکم ۀ استفاده می‌شود که به نحو ۀکارکرد 

آن در بخش 3-10-1 اشاره شده است. برای آشنایی با دکمه‌های نوارابزار انتخاب به جدول 1-8 دقت کنید.    
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جدول 1-8- کاربرد دکمه‌های مختلف نوار ابزار انتخاب

دکمۀ انتخابکاربرد
انتخاب بدون محدودیت )فعال نمودن تمامی دکمه‌های انتخاب به جز دکم ۀانتخاب تک بولت(

انتخاب ‌Componentها 

انتخاب قطعات )همانند تیر، ستون، ورق  و...(

)Surface treatments( انتخاب سطوح روی ۀاعضا

انتخاب نقاط

انتخاب خطوط و دوایر کمک ترسیمی

انتخاب مدل‌های مرجع ایمپورت شده

انتخاب خطوط شبکه یکپارچه

انتخاب تک خط شبکه

انتخاب جوش ها

انتخاب انواع برش ها

انتخاب نماهای مدل

انتخاب گروه بولت ها

انتخاب تک بولت 

انتخاب آرماتورهای منعطف 

انتخاب گروه آرماتورها 

انتخاب آرماتورهای منفرد

 Pour breaks انتخاب

)Construction Plane( انتخاب صفحات کمکی

انتخاب فواصل مرجع

انتخاب ‌Componentها 

انتخاب اجزای Component ها

انتخاب اسمبلی و واحدهای ساخت قطعات بتنی

انتخاب اجزای اسمبلی و واحدهای ساخت

)Task Manager( انتخاب دستورالعمل‌ها

دسترسی به فیلترهای انتخاب

انتخاب گیره‌ها به همراه خطوط اندازه برای اصلاح طول و شکل هندسی اجزای انتخاب شده
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 )Snapping Toolbar( 1-7-10- نوار ابزار ربایش
از این نوار ابزار و بخش‌های مختلف آن به منظور ربایش نقاط و لبه‌ها استفاده می‌شود که این نوع ربایش منجر به جانمایی 
صحیح موضوعات در مدل خواهد شـد. عملکرد دکمه‌های مختلف این نوار ابزار به گونه ایسـت که با فشـردن هریک از 
دکمه‌های ربایش، آن دکمه فعال می‌گردد و به هنگام ترسـیم اشـیا با نزدیک شـدن نشانگر موس به یکی از نقاط تنظیم شده 
)انتهـای عضـو، میانه عضو، گوشـ ۀخارجی عضو و...( آن نقطه خاصیت ربایش پیـدا کرده و قابل انتخاب می‌گردد. توضیح 

بخش‌های مختلف این نوار ابزار در جداول 1-9 و 1-10 آورده شده است. 

شکل 1-18- نوار ابزار ربایش

جدول 1-9- کاربرد دکمه‌های مختلف نوار ابزار ربایش

دکمۀ ربایشکاربرد
ربایش نقاط و تقاطع خطوط شبکه

ربایش نقاط انتهایی

ربایش نقاط در مرکز دوایر و کمان ها

ربایش نقاط میانی 

ربایش نقاط در محل تقاطع موضوعات

ربایش نقاط در امتداد عمود بر موضوعات

ربایش نقاط در امتداد خطوط مرجع و خطوط هندسی اعضا

ربایش بدون محدودیت )در هر موقعیت دلخواه(

ربایش نقاط به نزدیکترین نقط ۀروی لب ۀموضوعات

ربایش خطوط مرجع، خطوط شبکه و خطوط لبه‌های موضوعات )ربایش خطی(

ربایش نقاط مرجع )نقاط دارای گیره(

ربایش نقاط هندسی )نظیر نقاط گوشه(

جدول 1-10- کاربرد لیست‌های کرکره‌ای نوار ابزار ربایش

لیست کرکره ایعملکرد 

تنظیم کنند ۀمحدودیت ربایش نقاط در نماها می‌باشد بطورمثال اگر از گزین ۀPlane استفاده کنید صرفاً قادر 
به ربایش نقاط در پلان می‌باشید نه در فضای سه بعدی

بیانگر ربایش پیش فرض و یا ربایش منطبق بر محور مختصات محلی می‌باشـد. با تنظیم برروی گزینۀ
Work Plane  و تغییر محور مختصات محلی، خطوط شبکه در راستای محور مختصات محلی نیز قابل 

مشاهده و ربایش می‌باشند 

تنظیم کنند ۀنوع ربایش صفحات می‌باشد که به منظور عملیات آهنربایی کردن موضوعات از آن استفاده می‌گردد



فصل دوم
ابزارهای مدل سازی

در این فصل به ابزارهای تنظیم خطوط شبکه، دستورهای مدل‌سازی قطعات فلزی و نکات مربوط به آنها اشاره می‌شود که 
اکثریت آنها در تب Steel قرار گرفته‌اند. تب Steel به نوعی یکی از مهم ترین تب‌های نرم‌افزار تکلا است بطوریکه مدل‌سازی 
اعضایی همچون تیرها، ستونها، ورق‌ها و... همه در این تب انجام می‌پذیرد. قبل از اینکه به تشریح دستورهای مدل سازی 

بپردازیم نیاز است که با کاربرد خطوط شبکه که مبنای اصلی کار مدل سازی در تکلا است آشنا شویم.

2-1- خطوط شبکه مستطیلی و مورب
خطوط شبکه خطوط راهنمایی هستند که در پلان و نماهای مختلف مدل )ترازهای ارتفاعی( از آنها استفاده می‌گردد و کمک 
شایانی به مدل‌سازی صحیح پروژه می‌نماید بطوریکه در برخی از پروژه‌های خاص ممکن است از چندین نوع خطوط شبکه 
استفاده گردد. هنگامی که یک مدل جدید را ایجاد می‌کنیم نرم‌افزار خطوط شبک ۀپیش فرضی را نیز به همراه آن ایجاد می‌کند 

که می‌توان آن را اصلاح نمود و یا خطوط شبک ۀجدیدی تعریف کرد.
پس از اجرای دستور …Grid > Create Grid از تب Edit و یا دابل کلیک کردن بر روی آیکون این دستور   )و یا با 
دابل کلیک کردن برروی خطوط شبک ۀموجود( پنجر ۀمحاوره‌ای Grid گشوده می‌شود که در ادامه به شرح عملکرد بخش‌های 
مختلف این پنجره خواهیم پرداخت. )دقت داشته باشید که برای دابل کلیک کردن بر روی خطوط شبکه بایستی دکمه انتخاب 

Select grid در نوار ابزار انتخاب فعال باشد(

کادر Coordinates: در این بخش فواصل بین خطوط شـبکه تعیین می‌گردد. این فواصل برای محورهایX وY بصورت 
 T.O.B غالبا تراز روی تیر که در نقشـه‌های سـازه بصورت( بصورت مطلق Z و برای محور )نسـبی )فواصل بین دهانه ها

مشخص می‌شود( درج می‌گردد. فواصل دهانه‌های محور  X و Yرا به دو روش می‌توان تعریف کرد: 
در روش اول فواصل بین دهانه‌ها بصورت تک به تک و با یک فاصل ۀخالی )Space( از یکدیگر وارد می‌شود. به طور مثال 

فواصل راستای X  برای دو دهان ۀ5 متری همانند شکل زیر تنظیم می‌گردد:
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شکل 2-1- تنظیم طول دهانه‌های راستای X بصورت تک به تک

شکل 2-2- پنجرۀ محاوره‌ای تنظیم خطوط شبکه

در روش دوم که برای دهانه‌های مشابه بکار می‌رود نحو ۀتعریف طول دهانه‌ها همانند شکل زیر خواهد بود:

 X شکل 2-3- تنظیم طول دهانه‌های مشابه در راستای

همانطور که مشاهده می‌کنید اعداد وارد شده در فیلدهای X و Y با صفر شروع شده‌اند که نشانگر این موضوع است که 
اولین خط شبکه در راستای X و Y از مبدأ شروع شود. همچنین برای اینکه این اعداد همیشه مثبت باشند، مبدأ مختصات 
در گوشه پایین سمت چپ مستقر می‌شود. پس دقت کنیدکه اعداد محور Y از پایین به بالا وارد می‌شوند. )خطوط شبکه در 

ربع اول مختصاتی واقع می‌گردد(.
کادر Labels: از این بخش به منظور نامگذاری خطوط شبکه استفاده می‌گردد. خطوط شبکه در راستای محور X و Y اغلب 
با اعداد و حروف انگلیسی و در راستای محور Z براساس همان کدهای ارتفاعی وارد شده در بخش Coordinates نامگذاری 

می‌گردند که می‌توان در صورت نیاز این نوع نامگذاری را اصلاح نمود. 
 Z و Y و،X در این بخش می‌توان مقدار بیرون زدگی انتهایی خطوط شـبکه را در هر سـه راسـتای :Line Extensions کادر

تنظیم نمود. اعداد پیش فرض برای این منظور اغلب مناسب بوده و نیازی به تغییر آنها نمی باشد.

بیرون زدگی در 

راستای محور‌Yها 
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شکل 2-4- طول بیرون زدگی انتهایی خطوط شبکه 

کادر Origin: در این بخش مختصات مبدأ قرارگیری خطوط شبکه وارد می‌گردد. پیش فرض برنامه برای این منظور مبدأ 
مختصات اسـت که اغلب مناسـب بوده و نیازی به تغییر آن نمی باشـد. لازم به ذکر است که بلافاصله پس از اجرای دستور

 …Create Grid با کلیک برروی هر نقط ۀدلخواهی در مدل، مختصات آن نقطه در بخش Origin درج می‌گردد.

کادرMagnetism: در این بخش مقیدی اشیا نسبت به خطوط شبکه مشخص می‌گردد بطوریکه با جابجایی خطوط شبکه، 
 Magnetic grid اشیای موجود در مدل نیز همراه آن جابجا می‌گردند. برای مقیدی اشیا به خطوط شبکه، باید تیک تنظیمی

plane فعال گردد.

کادر Other Settings: با کمک این بخش می‌توان خطوط شـبکه را قفل نمود تا هیچگونه تغییرات ناخواسـته‌ای درآن به 
وجود نیاید. همچنین می‌توان اطلاعات تکمیلی دیگری از خطوط شبکه اعم از مقادیر جابجایی‌های احتمالی آن را نیز درج 
نمـود. بـرای قفل نمودن خطوط شـبکه، بر روی دکم ۀ…User-defined attributes کلیـک کرده و تنظیم Locked را برروی 

گزین ۀYes قرار می‌دهیم.

شکل 2-5- پنجره درج اطلاعات تکمیلی مربوط به خطوط شبکه 

پس از انجام تنظیمات موردنظر، با فشردن دکم ۀModify و پذیرفتن پیغام Replace Confirmation خطوط شبک ۀموجود 
اصلاح می‌گردند. لازم به ذکر است که در تکلا، پنجره‌های محاوره‌ای بر روی موضوعاتی اثر می‌گذارند که به حالت انتخاب 
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قرار داشته باشند )موضوعات با کلیک بر روی آنها به حالت انتخاب در می‌آیند(.
همچنین اگر مایل به ایجاد بیش از یک خط شـبکه باشـیم، باید پس از کلیک بر روی آیکون  و معرفی مبدأ خطوط 
شبکه جدید )با کلیک بر روی یک نقطه دلخواه( از دکم ۀCreate استفاده کنیم. مثال موجود در شکل 2-2- منتج به شکل 

زیر خواهد شد:

شکل 2-6- خطوط شبکه ایجاد شده با تنظیمات شکل 2-2

به طور پیش فرض واحد اندازه‌گیری اعداد وارد شده در پنجره محاوره‌ای Grid میلی متر بوده و می‌توان در صورت 
نیاز این واحد اندازه‌گیری را از مسیر زیر تغییر داد:

File > Settings > Options > Unit and decimals

2-1-1- ویرایش خطوط شبکه
پس از ایجاد خطوط شبکه اولیه ممکن است که در حین کار نیاز به اصلاح آن داشته باشیم و یا اینکه بخواهیم به طور موقتی 
تغییراتی در آن ایجاد کرده و پس از ترسیم موضوعات آن را به حالت اولیه باز گردانیم. بهترین راه اصلاح خطوط شبکه، دابل 
 Modify و سـپس زدن دکمه Grid کلیک کردن بر روی خطوط شـبکه موجود و درج اطلاعات جدید در پنجره محاوره‌ای
می‌باشد اما اگر درج اطلاعات در پنجره محاوره‌ای خطوط شبکه امکانپذیر نباشد )همانند خطوط شبکه مورب و زاویه دار( 
بایستی از روش‌های اصلاح هندسی خطوط شبکه استفاده کرد. پس از انتخاب خطوط شبکه، با جابجایی نشانگر موس و 

کلیک بر روی هر خط دلخواه می‌توان آن را توسط گیره‌های موجود در ابتدا و انتهای آن جابجا کرد. 
)دقت داشته باشید که دکمه Direct modification  از نوار ابزار انتخاب فعال باشد(.

2-1-1-1- ایجاد یک خط شبکه کمکی مابین دو خط شبکه موجود
برای اینکه بتوان ما بین دو خط شبکه موجود و یا بعد از یک خط شبکه انتهایی، خط شبکه جدیدی ایجاد کرد:

الف( دکمه Direct modification  را از نوار ابزار انتخاب فعال کنید.
ب( بر روی یک تک خط شبکه موجود کلیک کنید.

ج( بر روی آیکون  کلیک کنید تا یک خط شبکه تک ایجاد گردد که لیبل آن ترکیبی است از لیبل خطوط شبکه‌ای که 
ما بین آنهاست.
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D و E ما بین خط شبکه DE شکل 2-7- ایجاد خط شبکه جدید

2-1-1-2- ایجاد یک خط شبکه کمکی مابین دو نقطه
همانطور که در بخش قبلی مشاهده شد خط شبکه ایجاد شده مستقیم بود اما ممکن است که شما بخواهید خط شبکه مورب 

نیز ایجاد کنید در این صورت:
الف( در تب Edit و زیر مجموعه Grid دستور Add grid line را اجرا کنید.

Add grid line شکل 2-8- نحوه اجرای دستور

ب( بر روی خطوط شبکه موجود کلیک کنید )اگر در پروژه‌ای بیش از یک خط شبکه موجود باشد، خط شبکه ایجاد شده 
به گروهی که بر روی آن کلیک کرده اید پیوسته و با آنها یکپارچه می‌شود(.

ج( دو نقطه دلخواه که مایلید خط شبکه ما بین آنها ایجاد گردد را معرفی کنید تا خط شبکه جدید ایجاد گردد.

E-4 و A-1 شکل 2-9- ایجاد خط شبکه مورب مابین آکس‌های

همانطور که ملاحظه می‌کنید خط شبکه ایجاد شده لیبلی نداشته و با پنجره محاوره‌ای Grid نیز قادر به اصلاح آن نیستیم لذا 
در اینگونه مواقع ما نیاز خواهیم داشت که این خط‌های شبکه ایجاد شده را به شکل منفرد انتخاب )توسط نوار ابزار انتخاب( 

و اصلاح کنیم. که در ادامه به آن اشاره شده است:
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2-1-1-3- اصلاح خطوط شبکه به شکل منفرد
برای اصلاح یک خط شبک ۀمنفرد مراحل زیر را طی کنید: 

اطمینان حاصل کنید که دکم ۀانتخاب Select Grid Line  از نوار ابزار انتخاب فعال باشد.-11
خط شبکه‌ای را که مایل به اصلاح و یا حذف آن هستید انتخاب کنید. -22
با انتخاب خط شـبک ۀموردنظر، گیره‌های ابتدایی و انتهایی و همچنین صفح ۀدربرگیرند ۀآن خط شـبکه نمایش داده -33

می‌شود که می‌توان عملیاتی از قبیل کپی کردن، جابجایی، حذف، افزایش و کاهش طول و مورب نمودن خط شبکه 
را )با انتخاب و جابجایی گیر ۀابتدایی و یا انتهایی آن( انجام داد. همچنین با دابل کلیک کردن بر روی آن قادر خواهیم 

بود تا لیبل دلخواهی را نیز به آن اختصاص دهیم.

گیرۀ ابتدایی خط شبکه

شکل 2-10- انتخاب و اصلاح یک خط شبکۀ موجود

به هنگام انتخاب خطوط شـبکه یکپارچه و یا خط شـبکه منفرد، با کلیک بر روی آیکون  می‌توان به نوار ابزار 
کمکی دسترسی داشت و اطلاعاتی که در مباحث قبلی در پنجره Grid وارد می‌کردیم را به طور مستقیم وارد کنیم. 

2-2- خطوط شبکۀ شعاعی 
در نسـخه‌های جدید نرم‌افزار تکلا )بعد از نسـخه 14( ماکرویی قرار داده شـده است که می‌توان توسط آن خطوط شبکه 
را بصورت شعاعی نیز ایجاد نمود. این قابلیت می‌تواند کاربرد خوبی در پلان‌های دایره‌ای داشته باشد. برای ایجاد این گونه 

خطوط شبکه مراحل زیر را طی کنید: 
برروی آیکون Applications & Components  در نوار ابزار جانبی کلیک کنید.-11
عبارت Radial grid را در فیلد مربوط به جستجوی سریع ‌Componentها تایپ کنید.-22
ماکروی Radial Grid را با دابل کلیک کردن برروی آن انتخاب کنید.-33
تنظیمات مربوط به مختصات خطوط، نامگذاری خطوط و بیرون زدگی‌های آن را انجام دهید و سپس بر روی نقطه -44

دلخواهی کلیک کرده تا خطوط شبکه شعاعی ترسیم گردد. عملکرد تمامی فیلدهای موجود در این ماکرو همانند 
خطوط شبک ۀمعمولی می‌باشد با این تفاوت که مختصات Y در این ماکرو بصورت زاویه‌ای وارد می‌گردد و همچنین 

خاصیت Preview نیز در آن ایجاد شده است. درخطوط شبکه شعاعی:


